PASS Sample Size Software

NCSS.com

Chapter 295

Control Charts for
Variability (Simulation)
Introduction
This procedure allows you to study the run length distribution of R, S, and S with probability limits process control
charts using simulation. This procedure can also be used to study charts with two or more observations at each
sample. The in-control standard deviation can be input directly or a specified number of in-control preliminary
samples can be simulated based on a user-determined in-control distribution. This procedure can also be used to
determine the necessary sample size to obtain a given run length.

Simulation Details
If the in-control standard deviation is assumed to be known (standard), the steps to the simulation process are as
follows (assume a sample consists of n observations).
1. An out-of-control sample of size n is generated from a normal distribution with the specified out-of-control
standard deviation.
2. The standard deviation of the sample is calculated and compared to the control limits.
3. If the sample results in an out-of-control signal, the sample number is recorded as the run length for that
simulation. If the sample does not result in an out-of-control signal, return to Step 1.
4. Steps 1 through 3 are repeated until the number of simulations (Nsim) is reached. The result is Nsim run
lengths.
5. The average or median or specified percentile of the run length distribution is reported.
If the in-control standard deviation is to be simulated based on in-control preliminary samples (NPrelim), the steps to
the simulation process are as follows (assume a sample consists of n observations).
1. NPrelim in-control samples of size n are generated from a normal distribution with specified standard
deviation of the in-control distribution.
2. The in-control standard deviation is calculated based on the NPrelim simulated in-control samples.
3. An out-of-control sample of size n is generated from a normal distribution with the specified out-of-control
standard deviation.
4. The standard deviation of the sample is calculated and compared to the control limits.
5. If the sample results in an out-of-control signal, the sample number is recorded as the run length for that
simulation. If the sample does not result in an out-of-control signal, return to Step 3.
6. Steps 1 through 5 are repeated until the number of simulations (Nsim) is reached. The result is Nsim run
lengths.
7. The average or median or specified percentile of the run length distribution is reported.
295-1
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Control Charts for Variability (Simulation)

Formulas for Constructing Control Charts
The formula used for each set of control chart limits depends on whether the standard deviation is assumed to be a
known, standard value, or estimated from in-control preliminary samples.

R Chart Limits
If the standard deviation is a known, standard value, the lower and upper control limits for the R chart are
calculated (see Montgomery, 1991) using the formulae

LCL = d 2σ − z1−α / 2 d 3σ
UCL = d 2σ + z1−α / 2 d 3σ
where d 2 = R / σ and d 3 = σ R / σ .
If the limits are to be created from in-control preliminary samples, the lower and upper control limits for the R
chart are calculated using the formulae

LCL = R − z1−α / 2 d 3

R
d2

UCL = R + z1−α / 2 d 3

R
d2

The statistic that is compared to the limits at each subgroup is the subgroup range
R i = x ( n ) − x (1)

S Chart Limits
If the standard deviation is a known, standard value, the lower and upper control limits for the S chart are
calculated (see Montgomery, 1991) using the formulae

LCL = c4σ − z1−α / 2σ 1 − c42

UCL = c4σ + z1−α / 2σ 1 − c42
where

c4 =

n
Γ 
 2
2
n − 1  n − 1
Γ

 2 

If the limits are to be created from in-control preliminary samples, the lower and upper control limits for the S
chart are calculated using the formulae

LCL = S − z1−α / 2

S
1 − c42
c4

UCL = S + z1−α / 2

S
1 − c42
c4
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The statistic that is compared to the limits at each subgroup is the subgroup standard deviation
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S Chart with Probability Limits
If the standard deviation is a known, standard value, the lower and upper control limits for the S chart with
probability limits are calculated (see Ryan, 1989) using the formulae

χ α2 / 2

LCL = σ

n −1

χ12−α / 2

UCL = σ

n −1

If the limits are to be created from in-control preliminary samples, the lower and upper control limits for the S
chart with probability limits are calculated using the formulae

χ α2 / 2

S
LCL =
c4

n −1

χ12−α / 2

S
c4

UCL =

n −1

The statistic that is compared to the limits at each subgroup is the same as that of the previous S Chart, namely,
the subgroup standard deviation
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
Solve For
Solve For
Solve for either the run length distribution or the sample size. This is the parameter displayed on the vertical axis
of the plot.
Note: The search for the sample size may take several minutes to complete. You may find it quicker and more
informative to solve for run length distribution for a range of sample sizes.
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Simulations
Simulations
Specify the number of Monte Carlo iterations. Each simulation consists of the full process required to obtain a run
length. That is, the number of simulations here is the number of run lengths that are used to form the run length
distribution.
A 2007 article in Communication in Statistics-Simulation and Computation suggests that 5000 to 10000
simulations is usually sufficient. For estimating percentiles near 0 or 1, more simulations may be needed.
For searches for N, you may wish to use fewer simulations to determine the ballpark for N and then larger
numbers of simulations for fine-tuning.
Maximum Run Length
For each simulation, if the run length reaches the maximum run length, the maximum run length is used for that
simulation. This keeps simulations from going on indefinitely when run lengths are extremely long.
For example, if the average run length is close to the maximum run length, the maximum run length should be
increased.

Run Length
Run Length Summary 1 and 2
Select the first and second run length distribution summary value to be reported.
If a value between 0 and 1 (not inclusive) is entered, the corresponding distribution percentile is reported.
For example, if 0.40 is entered, the run length such that 40% of simulated run lengths are shorter is reported.
Percentile or Average
When solving for N, the value entered for "Percentile or Average" indicates whether the search is based on the
average run length or some percentile, such as the median.
If a value between 0 and 1 (not inclusive) is entered, the corresponding distribution percentile is used in the search
for N.
For example, if ARL (Average Run Length) is entered, and "Run Length" is 10, the program will search for the
smallest N for which the average run length is 10.if 0.40 is entered, and "Run Length" is 10, the program will
search for the smallest N for which 40% of simulated run lengths are shorter than 10.
Run Length
When solving for N, this is run length that is searched for based on the specified "Percentile or Average".
For example, if ARL (Average Run Length) is entered, and "Run Length" is 10, the program will search for the
smallest N for which the average run length is 10.if 0.40 is entered, and "Run Length" is 10, the program will
search for the smallest N for which 40% of simulated run lengths are shorter than 10.

Sample Size
N (Sample Size)
Enter a value for the sample size, N. This is the number of observations in each sample. This sample size is also
used when preliminary samples are used.
When a sample size of one is used, the preliminary sample standard deviation is estimated with all the preliminary
data jointly.
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You may enter a range such as 2 to 10 by 2 or a list of values separated by commas or blanks.
You might try entering the same number two or three times to get an idea of the variability in your results. For
example, you could enter "10 10 10".

Distributions, Tests Tab
In-Control and Out-of-Control Distributions
In-Control Distributions Specified By
Specify whether a standard known standard deviation will be used for the standard deviation for control limits, or
if the standard deviation for control limits will be based on simulated preliminary samples.

In-Control and Out-of-Control Distributions Known
In-Control Standard Deviation
This is an assumed known standard deviation from which the boundaries are calculated.

In-Control and Out-of-Control Distributions –
Preliminary Samples
In-Control Distribution Standard Deviation
This is the standard deviation of the normal distribution that is used to simulate preliminary samples.
You can enter a single value or a list of values using the syntax 1 2 3 or 1 to 5 by 1.
Number of Preliminary Samples
For each run length simulation, this is the number of samples that are simulated to determine the range or standard
deviation for calculating the limits of the control chart.
For example, if a control chart uses 50 samples with N = 5 to establish the in-control standard deviation, 50
should be entered here. The program will generate 50 samples of size 5 each, obtain standard deviations (or
ranges) for each sample and use those to produce a standard deviation (or range) estimate as a basis for the
simulated control chart.
Commonly recommended numbers of in-control preliminary samples are 30, 50, and 60.
Varying this number allows one to see the effect on the distribution of run lengths.

In-Control and Out-of-Control Distributions – Outof-Control
Out-of-Control Standard Deviation
This is the standard deviation of the out-of-control distribution. Out-of-control samples are simulated based on a
normal distribution with this standard deviation.
You can enter a single value or a list of values using the syntax 1 2 3 or 1 to 5 by 1.
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Tests
Include Tests
Specify whether to include this test in the Reports and Plots. The specific options for each test are specified
below.

Tests – Z or Probability Options
Specify Probability Using
For R and S charts, specify whether the Z-multiplier will be input directly or calculated based on the probability.
The Z-multiplier is the value of Z in the chart formula for the limits:
Rbar +/- Z * SD_R for two-sided R charts, and
Sbar +/- Z * SD_S for two-sided S charts.
For S with Probability Limits, if a Z-multiplier is specified, the probability corresponding to the Z-multiplier is
used to create the limits.
Z-Multiplier
The Z-multiplier is the value of Z in the chart formula for the limits:
Rbar +/- Z * SD_R for two-sided R charts, and
Sbar +/- Z * SD_S for two-sided S charts.
For S with Probability Limits, the probability corresponding to the Z-multiplier is used to create the limits.
You can enter a list of values using the syntax 2 3 4 or 2 to 5 by 0.5.
Probability
For R and S charts, the probability is used to determine the Z-multiplier for the limits:
Rbar +/- Z * SD_R for two-sided R charts, and
Sbar +/- Z * SD_S for two-sided S charts.
For S with Probability Limits, the probability is used directly to create the limits using the chi-square distribution.
For two-sided tests, the probability is divided by two (for each side).
You can enter a list of values using the syntax 0.001 0.002 0.003 or 0.001 to 0.005 by 0.001.
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Example 1 – Run Length Distribution
A researcher wishes to examine the run length distribution for a process monitored by an R chart. Ten
observations are to make up the sample examined at each hour. The in-control standard deviation is known to be
3.8. The researcher would like see the run length distribution if the out-of-control standard deviation is 4.6. A
probability of 0.00135 is to be used in the control chart for the boundaries.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Control Charts for Variability (Simulation) procedure window by clicking on Quality
Control, and then clicking on Control Charts for Variability (Simulation). You may then make the appropriate
entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Run Length Distribution
Simulations ............................................. 5000
Maximum Run Length............................. 5000
Run Length Summary 1 .......................... ARL (Average Run Length)
Run Length Summary 2 .......................... MRL (Median Run Length)
N (Sample Size)...................................... 10
Distributions, Tests Tab
In-Control Distributions Specified By ...... Standard Deviation Directly
In-Control Standard Deviation ................ 3.8
Out-of-Control Standard Deviation ......... 4.6
R ............................................................. Checked
All Other Tests ........................................ Unchecked
Two-Sided or Upper Limit Only .............. Upper Limit Only
Specify Probability Using ........................ Probability
Probability ............................................... 0.00135

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Control Charts for Process Variability
Control limits were determined by specifying a standard in-control standard deviation directly.
Out-of-Control Distribution: Normal with Out-of-Control SD

Chart
Type
R

Average
Run
Length
22.0

Median
Run
Length
15.0

InOneControl
Sided
N
SD
Prob
10 3.8000 0.00135

Z
3.205

LCL
UCL
0.0000 20.7821

Out-ofControl
SD
4.6000

Notes
Simulations: 5000. Run Time: 4.0 seconds.
References
Ryan, T.P. 1989. Statistical Methods for Quality Improvement. Wiley. New York.
Montgomery, D.C. 1991. Introduction to Statistical Quality Control. Wiley. New York.
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Report Definitions
Average Run Length is the mean of the run lengths across all simulations.
Median Run Length is the median of the run lengths across all simulations.
N is the number of units measured in each sample.
In-control SD is the assumed known standard value of the standard deviation.
One-Sided Prob is the probability of a sample range or standard deviation outside the control limits.
Z is the Z-multiplier which corresponds to the One-sided probability of a single sample range or standard
deviation outside the control limits.
In-control SD is the assumed known standard deviation that is used in the calculation of limits.
LCL and UCL are the lower and upper control chart limits, respectively.
Out-of-Control SD is the standard deviation of the normal distribution from which out-of-control samples are
drawn.
Summary Statements
For an R control chart with lower and upper control limits of 0.0000 and 20.7821, respectively,
samples of size 10 from a normal distribution with standard deviation 4.6000 have an average
run length of 22.0 and a median run length of 15.0. These results are based on 5000 Monte Carlo
samples.
Individual Summaries
Control limits were determined by specifying a standard in-control standard deviation directly.
Out-of-Control Distribution: Normal with Out-of-Control SD

Chart
Type
R

Average
Run
Length
22.0

Median
Run
Length
15.0

InOneControl
Sided
N
SD
Prob
10 3.8000 0.00135

Z
3.205

LCL
UCL
0.0000 20.7821

Out-ofControl
SD
4.6000

Average Run Length 95% CI: (21.4, 22.6)
Median Run Length 95% CI: (15.0, 16.0)
Average Run Length and Percentiles
Avg
1%
5% 10%
25%
22.0
1.0
2.0 3.0
7.0

50%
15.0

75%
30.0

90%
50.0

95%
66.0

99%
103.0

The results will vary slightly because they are based on simulation.

Plots Section

This plot shows the distribution of run lengths of 5000 simulated runs.
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Example 2 – Comparing Tests
Continuing with the Example 1 parameters, the researchers would like to compare the various control chart tests
available.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Control Charts for Means (Simulation) procedure window by clicking on Quality Control,
and then clicking on Control Charts for Means (Simulation). You may then make the appropriate entries as
listed below, or open Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Run Length Distribution
Simulations ............................................. 5000
Maximum Run Length............................. 5000
Run Length Summary 1 .......................... ARL (Average Run Length)
Run Length Summary 2 .......................... MRL (Median Run Length)
N (Sample Size)...................................... 10
Distributions, Tests Tab
In-Control Distributions Specified By ...... Standard Deviation Directly
In-Control Standard Deviation ................ 3.8
Out-of-Control Standard Deviation ......... 4.6
All Tests .................................................. Checked
Two-Sided or Upper Limit Only .............. Upper Limit Only
Specify Probability Using ........................ Probability
Probability ............................................... 0.00135

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Control Charts for Process Variability
Control limits were determined by specifying a standard in-control standard deviation directly.
Out-of-Control Distribution: Normal with Out-of-Control SD

Chart
Type
R
S
S Prob

Average
Run
Length
22.2
21.5
33.7

Median
Run
Length
16.0
15.0
24.0

N
10
10
10

InOneControl
Sided
SD
Prob
3.8000 0.00135
3.8000 0.00135
3.8000 0.00135

Z
3.205
3.205

LCL
UCL
0.0000 20.7821
0.0000 6.3436
0.0000 6.5931

Out-ofControl
SD
4.6000
4.6000
4.6000

The R and S control chart tests show the process is out-of-control a bit sooner than the S test with probability
limits.
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Example 3 – Validation Using Ryan
Ryan (1989), page 93, indicates that in-control processes with a sample size of 4 at each look will have a false
signal on average after 222 samples for the S test, while the S with Probability Limits test will only give a false
positive after 741 (1/0.00135) samples.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Control Charts for Means (Simulation) procedure window by clicking on Quality Control,
and then clicking on Control Charts for Means (Simulation). You may then make the appropriate entries as
listed below, or open Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Run Length Distribution
Simulations ............................................. 10000
Maximum Run Length............................. 5000
Run Length Summary 1 .......................... ARL (Average Run Length)
Run Length Summary 2 .......................... MRL (Median Run Length)
N (Sample Size)...................................... 4
Distributions, Tests Tab
In-Control Distributions Specified By ...... Standard Deviation Directly
In-Control Standard Deviation ................ 3.8
Out-of-Control Standard Deviation ......... 3.8
R ............................................................. Unchecked
S.............................................................. Checked
S with Probability Limits .......................... Checked
Two-Sided or Upper Limit Only .............. Upper Limit Only
Specify Probability Using ........................ Probability
Probability ............................................... 0.00135

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Control Charts for Process Variability
Control limits were determined by specifying a standard in-control standard deviation directly.
Out-of-Control Distribution: Normal with Out-of-Control SD

Chart
Type
S
S Prob

Average
Run
Length
221.7
737.3

Median
Run
Length
152.0
501.0

InOneControl
Sided
N
SD
Prob
4 3.8000 0.00135
4 3.8000 0.00135

Z
3.205

LCL
0.0000
0.0000

UCL
7.9334
8.6738

Out-ofControl
SD
3.8000
3.8000

The average run lengths are very close to those presented in Ryan (1989).
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